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Introduction
Welcome to Microsoft® Business Solutions Requisition Management. Requisition 
Management is a Web-based business application that you can use to create, 
approve, and modify purchase requests using Business Portal. 

When you submit purchase requests in Requisition Management, the requests are 
routed to the appropriate individuals for review and approval, and then transferred 
to Microsoft Business Solutions–Great Plains® for processing. 

This introduction includes the following sections:

• What’s in this manual
• Symbols and conventions
• Additional resources

What’s in this manual

The Requisition Management User’s Guide is designed for users who enter or 
approve purchase requests, and users who convert purchase requests to purchase 
orders. This documentation is divided into the following chapters: 

• Chapter 1, “Key Concepts,” explains user roles, Requisition Management key 
concepts, and the purchase request life cycle. 

• Chapter 2, “Creator Tasks,” describes how to enter, print, and modify a 
purchase request. 

• Chapter 3, “Approver Tasks,” explains how to approve, reject, and void a 
purchase request. 

• Chapter 4, “Purchaser Tasks,” describes how to convert line items from 
purchase requests into purchase orders. 

Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and suggestions.

The warning symbol indicates situations you should be especially aware 
of when completing tasks. Typically, this includes cautions about 
performing steps in their proper order, or important reminders about 
how other information in Business Portal or the back office might be 
affected.



I N T R O D U C T I O N

2 R E Q U I S I T I O N M A N A G E M E N T U S E R ’ S G U I D E

This manual uses the following conventions to refer to sections, navigation and 
other information.

Additional resources

In addition to this manual, the following documentation is included with this 
release of Business Portal.

Manuals
The following PDF manuals are included in the Documentation folder on the 
Business Portal CD.

Business Portal Installation Guide The Installation Guide 
(BusinessPortalInstallation.pdf) provides step-by-step instructions for installing 
Business Portal.

Business Portal Administrator’s Guide The Administrator’s Guide 
(BusinessPortalAdminGuide.pdf) explains how to set up and configure Business 
Portal.

Business Portal User’s Guide The User’s Guide 
(BusinessPortalUsersGuide.pdf) helps users complete day-to-day tasks in Business 
Portal.

Application manuals User and Administrator manuals for each application 
installed in Business Portal are available in the Documentation folder.

Online help
Online help is available in Business Portal by choosing the Help menu, located at 
the top-right corner of Business Portal. The items that appear in the Help menu are 
determined by your role and the applications that are installed.

Your role The help is written for two main audiences: users and administrators. If 
you’re assigned to an administrator role, administrator help will be available to you 
from the Help menu. If you’re not assigned to an administrator role, only the user 
help will be available to you.

Applications that are installed The applications that were installed with 
Business Portal also determine which items appear in the Help menu. For example, 
if you installed Requisition Management, the Requisition Management help will be 
available in the Help menu.

Keep in mind, each item shown in the Help menu is a self-contained help set. This 
means that if you’re currently viewing a user help topic, the administrator help 
topics won’t be available in the Contents or Index lists of Business Portal Help. Or, 

Convention Description

Creating a purchase 
request

Italicized type indicates the name of a section or procedure.

File > Print The (>) symbol indicates a sequence of actions, such as choosing items 
from a menu or a toolbar or pressing buttons in a window. This example 
directs you to go to the File menu and choose Print.

Bold Bold type indicates navigation, tab names, menus, commands, buttons, 
field names, keywords, and functions.

TAB or ENTER Small capital letters indicate a key or a key sequence.
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if you’re viewing a KPI help topic, the Requisition Management topics won’t be 
available in the Contents or Index lists. To view the topics in another help set, you 
must choose that set from the Help menu in Business Portal.

Windows® SharePoint® Services help  Many of the features included in 
Business Portal—such as document libraries, lists, announcements, links, and 
alerts—are provided by Windows SharePoint Services. General information about 
these features is provided in Business Portal administrator help. For more detailed 
information, refer to Windows SharePoint Services help, which can be accessed by 
clicking the Help link at the top left side of any SharePoint page or in any 
SharePoint Web Part menu. A list of the SharePoint pages included in Business 
Portal is also provided in Business Portal administrator help. 
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Chapter 1: Key Concepts
This information explains concepts you need to understand when using Requisition 
Management. Understanding these concepts will help you manage purchase 
requests more effectively. Key concepts information is explained in the following 
sections:

• Requisition Management overview
• Purchase request life cycle
• Approval hierarchy
• Requisition Management relationship with Great Plains

Requisition Management overview

Requisition Management is an application that employees, managers, supervisors, 
and purchasers can use to enter and approve purchase requests in Business Portal. 
Purchase requests, which are requests for goods or services, are routed to the 
appropriate users for review and approval, and then line items are transferred to 
new or existing Great Plains purchase orders. Requisition Management eliminates 
the need for a paper-based system and provides remote employees with an easy 
way to enter purchase requests.

You can use Requisition Management to:

• Enter, approve, or reject purchase requests in Business Portal.
• Route purchase requests to a supervisor for review.
• View the status of a purchase request and its history information.
• Transfer line items to new or existing Great Plains purchase orders.
• Consolidate line items from multiple purchase requests into a single purchase 

order for each vendor.

Purchase request life cycle

The purchase request life cycle includes all the steps or phases a purchase request 
passes through: creation, submission, and conversion. The life cycle in a company is 
defined by the approval hierarchy, which the Requisition Administrator sets up. 
See Approval hierarchy on page 6 for more information.

Creation phase
When you enter a purchase request, you’re considered the creator. You can save the 
request and modify it later, or you can submit it to the approver.

Approval phase
After a purchase request is submitted, it’s routed to the designated approver, who 
can void, reject, or approve the request. An approver also can modify a request—
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such as adding required information or correcting errors—and save it to act on 
later.

If the approver has final approver status and the purchase request is within the 
specified approval limit, the approver can give the request final approval. The 
purchase request is routed to the purchaser.

Conversion phase
After a purchase request has received final approval, the purchaser—the user who 
was assigned to the Requisition Purchaser role when Requisition Management was 
set up—can transfer the request line items to purchase orders. A purchaser also can 
void or modify a line item—such as adding required information or correcting 
errors—and save it to act on later.

Approval hierarchy

The Requisition Administrator sets up the approval hierarchy, which controls the 
overall approval process. This approval hierarchy is the route a purchase request 
follows from one approver to the next until the request is converted to a purchase 
order. The hierarchy structure shows the roles or users who must approve a 
purchase request before it can become a purchase order. As a request is approved, it 
travels up the approval tree to the role or user in the next highest level. 

The following illustration shows an example of an approval hierarchy. 

Action Description

Void Stops all further action on the purchase request and sends it to history.

Save Saves any changes to the purchase request; no other action is taken and the 
approver can act on the request later.

Reject Returns the purchase request to the creator, who can modify it and resend to the 
approver.

Modify Opens the purchase request, allowing the approver to modify it. For example, if the 
quantity of the item is incorrect, the approver can enter the correct quantity.

Approve Routes the purchase request to the next approver in the approval hierarchy.

Action Description

Void Stops all further action on the purchase request line.

Save Saves any changes to the purchase request line; no other action is taken and the 
purchaser can act on the request line later.

Modify Opens the purchase request, allowing the purchaser to modify it. For example, if 
the item quantity is incorrect, the purchaser can enter the correct quantity.

Create Transfers the purchase request line items to new or existing Great Plains purchase 
orders.
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Requisition Management relationship with Great 
Plains

After a purchase request has been created, passes through the approval process, and 
receives final approval, a user in the Requisition Purchaser role will transfer the 
purchase request line items to new or existing Great Plains purchase orders. During 
the transfer process, the purchaser can consolidate identical line items from 
multiple purchase requests into one line item for one vendor. The purchaser can 
transfer line items in Requisition Management without being set up as a Great 
Plains back office employee.
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Chapter 2: Creator Tasks
As a Requisition Creator, you can create, save, modify, delete, view, and submit 
purchase requests.

If you create a purchase request but are not ready to submit it, you can save the 
request and submit it at a later time. To add or remove an item, you can return to 
the request, modify it, and save it again. If you later decide you don’t need the 
purchase request, you can delete it. If you’ve entered all the necessary information, 
you can submit the purchase request to your approver.

Creator task information is explained in the following sections:

• Creating a purchase request
• Additional purchase request tasks
• Adding a purchase request item
• Modifying a purchase request
• Viewing a saved purchase request
• Deleting a purchase request or line item
• Submitting a purchase request
• Copying a purchase request
• Voiding a purchase request or line item
• Resubmitting a purchase request
• Printing a purchase request
• Viewing the history for a purchase request

Creating a purchase request

Use the Purchase Request Details page to create a purchase request. You can either 
save or submit the request. If you save it, you can return to it at a later time. If you 
submit it, the purchase request is routed to your approver.

The information that’s required to create a purchase request will vary, depending 
on how the Requisition Administrator set up the system. For example, you may or 
may not have access to the Account, Item Number, Price, Site ID, or Vendor ID 
line item fields.

To create a purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. Click New Request. The Purchase Request Details page is displayed.

3. Enter a title for the request.

4. Click New Item to add an item to the request. The Add Item dialog box 
appears. See Adding a purchase request item on page 10 for more information.

5. When you finish adding the items, enter any comments about the purchase 
request in the Send comments to the next approver area. 
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6. Choose one of the following actions:

• Click Save to save the request. You can return to it at a later time and 
submit it.

• Click Submit to submit the request to your approver. 

You also can click Show More Tasks to view additional tasks and more flexible 
routing options. See Additional purchase request tasks on page 10 for more 
information.

Additional purchase request tasks

When you’re using the Purchase Request Details page to create or modify a 
purchase request, you can click Show More Tasks to view additional tasks and 
more flexible routing options for the request. You can select the following options.

Adding a purchase request item

Use the Add Item dialog box to add an item to a purchase request. You can add 
items to a new or saved request, or to a request that was submitted by you but was 
rejected by an approver.

To add a purchase request item:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. Click New Request to add an item to a new purchase request. To add an item to 
an existing request, select the request and click Edit Request. The Purchase 
Request Details page is displayed.

3. Click New Item to add items to the request. The Add Item dialog box appears.

Depending on the permissions the Requisition Administrator gave you, you might not 
have access to all the fields on this page. You don’t need to enter information in all the 
fields to save or submit the purchase request.

Option Description

Save as Draft Saves the purchase request without submitting it to your approver.

Submit and send the 
purchase request to

Routes the purchase request to someone other than your default 
approver. Depending on your permissions, you might be able to select 
your approver.

Submit to final 
approver

Routes the purchase request to the next person in the approval hierarchy 
who has final approver status. This option is available if the purchase 
request amount is within your approval limit, but you don’t have final 
approval permission.

Final Approve Gives the purchase request final approval and sends it to the Requisition 
Purchaser. This option is available if the purchase request amount is 
within your approval limit and you have final approval permission.

Delete Deletes the purchase request. You can delete a request only if it hasn’t 
been submitted. See Deleting a purchase request or line item on page 12 
for more information.
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4. Enter or select an item number. 

If the Requisition Administrator gave you access to add non-inventoried items 
to purchase requests, you can enter an item number that doesn’t exist in Great 
Plains.

5. Enter a description for the item. If you entered an item number for an existing 
item, the description from Inventory will appear next to the item number.

6. Enter or select the vendor for this item.

If you select an item and then click the Vendor lookup button, only the vendors 
assigned to the item will be displayed. You can click Show All Vendors to 
display all the vendors.

7. Select an account.

8. Enter or select the site where the item should be shipped.

9. Enter the price of the item.

10. Enter the quantity to receive.

11. If the item is non-inventoried, enter the unit of measure for the item. If the item 
is inventoried, the unit of measure will be displayed.

After you enter the unit of measure, the extended price is automatically 
calculated (Price * Quantity).

12. Enter or select the date when you need to receive the item.

13. If you have any comments about the item, enter them in the Comments field.

14. Click Save and Close to add the item to the new purchase request. Repeat steps 
3 through 13 to add additional items to the request. 

Modifying a purchase request

Use the Purchase Request Details page to make changes to a purchase request. You 
can modify a request if you saved it but haven’t yet submitted it. You also can 
modify a request if it was rejected and sent back to you. However, you can’t modify 
a request if it is being modified by another user, if it was voided, or if the line items 
were transferred to new or existing Great Plains purchase orders.

To modify a purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select My saved requests and click the arrow button.

3. Select the purchase request to modify and click Edit Request. The Purchase 
Request Details page appears.
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4. To modify the item information, select one of the following actions:

• To modify an item, select the item and click Edit Item. The Edit Item dialog 
box appears. Modify the item and click Save and Close when you’ve 
finished.

• To add an item, click New Item. The Add Item dialog box appears. Add an 
item and click Save and Close when you’ve finished. See Adding a purchase 
request item on page 10 for more information.

• To delete an item, select the item and click Delete Item. You can delete an 
item only if it hasn’t been submitted. See Deleting a purchase request or line 
item on page 12 for more information.

• To void an item, select the item and click Void Item. You can void an item if 
it was previously submitted. See Voiding a purchase request or line item on 
page 14 for more information.

Depending on the permissions the Requisition Administrator gave you, you might not 
have access to all the fields in the Edit Item and Add Item dialog boxes.

5. Click Save to save the modified purchase request or Submit to submit it to your 
approver.

You also can click Show More Tasks to select more options. See Additional 
purchase request tasks on page 10 for more information.

6. Click OK.

Viewing a saved purchase request

Use the Purchase Requests page to view purchase requests that have been saved 
but not submitted. Any rejected requests also will be displayed.

To view a saved purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select My saved requests and click the arrow button to 
display the purchase requests that are saved but not submitted, or that have 
been rejected.

You can click the various column headings on this page to sort the purchase 
requests.

Deleting a purchase request or line item

You can use the Purchase Request Details page to delete a purchase request or line 
item if the request hasn’t yet been submitted. The deleted request or line item will 
be removed from the system.
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To delete a purchase request or line item:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select My saved requests and click the arrow button.

3. Select the purchase request you’re deleting or the request that contains the line 
items you’re deleting. Click Edit Request. The Purchase Request Details page 
appears.

4. Complete one of the following tasks:

• To delete a line item, select the line and click Delete Item. A message 
appears asking if you want to delete the line. Click Yes. The line item is 
removed from the database. Click Save to save the modified request or 
Submit to submit it to your approver. 

• To delete the purchase request, click Show More Tasks. Select Delete and 
click OK. A message appears asking if you want to delete the purchase 
request. Click Yes. The request and all of its line items are removed from the 
database.

Submitting a purchase request

Use the Purchase Request Details page to submit a purchase request to your 
approver. Before you submit a purchase request, the Requisition Administrator 
must add you to the approval hierarchy. If you are not in the approval hierarchy, 
you still can create and save a request, but you won’t have permission to submit it. 
See Approval hierarchy on page 6 for more information.

To submit a purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select My saved requests and click the arrow button.

3. Select the purchase request to submit.

4. Click Edit Request. The Purchase Request Details page appears.

5. Click Submit to submit the request to your approver. 

You also can click Show More Tasks to select more options. See Additional 
purchase request tasks on page 10 for more information.

6. Click OK.

Copying a purchase request

Use the Purchase Request Details page to create a purchase request by copying an 
existing request. You can copy purchase requests only if the Requisition 
Administrator set up the system to allow copying.
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You can copy purchase requests if they’ve been:

• Saved but not submitted for approval
• Rejected and sent back to you
• Voided and sent to history

To copy a purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select one of the following options and click the arrow 
button:

Assigned to me Displays the requests assigned to you.

Assigned to my roles Displays the requests assigned to the role you select.

My open requests Displays your submitted requests that haven’t been 
transferred to purchase orders yet.

My saved requests Displays your unsubmitted and rejected requests.

My completed requests Displays your requests that were voided or the 
line items that were transferred to purchase orders.

Assigned to my subordinates Displays the requests assigned to the 
subordinate you select. Subordinates are users who are lower than you in the 
approval hierarchy. This option is available if the Requisition Administrator set 
you up as an extended approver, allowing you to approve requests assigned to 
your subordinates.

3. Select the purchase request to copy.

4. Click Copy Request. The Purchase Request Details page appears. 

5. Enter a title for the copied request.

6. To modify the copied request, click New Item to add an item, or select the item 
and click Edit Item or Delete Item to modify or delete an item. For more 
information, see Adding a purchase request item on page 10, Modifying a purchase 
request on page 11, and Deleting a purchase request or line item on page 12.

7. Click Save to save the copied request or Submit to it to your approver. 

You also can click Show More Tasks to select more options. See Additional 
purchase request tasks on page 10 for more information.

8. Click OK.

Voiding a purchase request or line item

You can use the Purchase Request Details page to void a purchase request or line 
item if the request has been rejected by an approver. When you void a purchase 
request, both the request and all of its line items are voided and moved to history. If 
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you void a line item, it will remain on the request, but it will be designated as 
having been voided.

A purchase request must include at least one non-voided line item if you want to resubmit it 
for approval.

To void a purchase request or line item:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select My saved requests and click the arrow button.

3. Select the request you’re voiding or the request that contains the line item 
you’re voiding and click Edit Request. The Purchase Request Details page 
appears.

4. Complete one of the following tasks:

• To void an item, select the item and click Void Item. A message appears 
asking if you want to void the line. Click Yes. The line item will remain on 
the request, but will be designated as voided. Click Save to save the request 
or Resubmit to resubmit it. See Resubmitting a purchase request on page 15 
for more information about resubmitting purchase requests.

• To void the request, click Show More Tasks. Select Void and click OK. A 
message appears asking if you want to void the purchase request. Click 
Yes. The request and all of its line items are voided and moved to history.

Resubmitting a purchase request

You can use the Purchase Request Details page to resubmit a purchase request if it 
has been rejected by an approver. You also can select a specific user or role to 
resubmit the request to, if you have permission to change your approver and you 
have more than one approver in the hierarchy.

To resubmit a purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select My saved requests and click the arrow button.

3. Select the request to resubmit and click Edit Request. The Purchase Request 
Details page appears.

4. Make any necessary changes to the request. See Modifying a purchase request on 
page 11 for more information.

5. Complete one of the following tasks:

• To resubmit the request to your default approver, click the Resubmit 
button.

• To resubmit the request to a specific user or role, click Show More Tasks. 
Select Resubmit and send the purchase request to and select a user or role 
from the list. Click OK.
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Printing a purchase request

You can use the Printer-Friendly Version page to print a purchase request. You 
don’t need to save the request before printing it.

To print a purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select one of the following options and click the arrow 
button:

Assigned to me Displays the requests assigned to you.

Assigned to my roles Displays the requests assigned to the role you select.

My open requests Displays your submitted requests that haven’t been 
transferred to purchase orders yet.

My saved requests Displays your unsubmitted and rejected requests.

My completed requests Displays your requests that were voided or the 
line items that were transferred to purchase orders.

Assigned to my subordinates Displays the requests assigned to the 
subordinate you select. Subordinates are users who are lower than you in the 
approval hierarchy. This option is available if the Requisition Administrator set 
you up as an extended approver, allowing you to approve purchase requests 
assigned to your subordinates.

3. Select the request to print and click View Request. The Purchase Request 
Details page appears.

4. Click Printer-Friendly Version to display a printer-friendly version of the 
request.

Voided items appear in strikethrough text.

5. Choose File > Print to print the request. 

Viewing the history for a purchase request

You can use the Purchase Request Approval History page to view history 
information for purchase requests that have been submitted, approved, submitted 
to the final approver, final approval, returned, rejected, resubmitted, or voided. 
When you view history for a submitted request, you can see when the request was 
approved, who approved it, when the line items were transferred to new or existing 
Great Plains purchase orders, and who transferred them.
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To view the history for a purchase request:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select My completed requests and click the arrow button to 
view your voided purchase requests or the requests that have been transferred 
to Great Plains as a purchase order.

3. Select the request to view and click View Request. The Purchase Request 
Details page appears.

4. Click Approval History. The Purchase Request Approval History page 
appears. The Approval history record list displays who has taken action on the 
request and what the last action was. 

5. To view an earlier version of the request, select an approval history record from 
the list.

6. Close the page when you’ve finished.
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Chapter 3: Approver Tasks
If you’re assigned to the Requisition Approver role and a purchase request is 
submitted to you, you’ll review the request and, if needed, modify it by adding, 
modifying, or voiding line items. Then you’ll approve, final approve, return, void, 
or reject the request.

This information describes the steps you need to follow when approving purchase 
requests. Approver task information is explained in the following sections:

• Approving a purchase request
• Additional approval tasks
• Modifying a purchase request before approving it
• Returning a purchase request to another user
• Rejecting a purchase request
• Voiding a purchase request or line item

Approving a purchase request

You can use the Purchase Request Details page to approve a purchase request. You 
also can use this page to return, reject, or void the request.

To approve a purchase request:
1. Open the Purchase Requests page.

Manager > Purchase Requests

2. In the Filter by list, select one of the following options:

Assigned to me Displays the requests assigned to you.

Assigned to my roles Displays the requests assigned to the role you select.

Assigned to my subordinates Displays the requests assigned to the 
subordinate you select. Subordinates are users who are lower than you in the 
approval hierarchy. This option is available if the Requisition Administrator set 
you up as an extended approver, allowing you to approve purchase requests 
assigned to your subordinates.

3. Select the request to approve and click Edit Request. The Purchase Request 
Details page appears.

4. If you have any comments about the request, enter them in the Comments field.

5. Click Approve to approve the request. 

You also can click Show More Tasks to view additional tasks and more flexible 
routing options. See Additional approval tasks on page 20 for more information.

Before you give the request final approval, be sure all the item fields are completed.

6. Click OK.
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Additional approval tasks

When you’re using the Purchase Request Details page to approve or modify a 
purchase request, you can click Show More Tasks to view additional tasks and 
more flexible routing options for the request. You can select the following options.

Modifying a purchase request before approving it

You can use the Purchase Request Details page to modify a purchase request 
before approving. You should modify the request if it is missing information or has 
incorrect information. For example, if the creator entered the incorrect vendor or 
didn’t enter the item number for an item, you can add the correct information.

To modify a purchase request before approving it:
1. Open the Purchase Requests page.

Employee > Purchase Requests

2. In the Filter by list, select one of the following options:

Assigned to me Displays the requests assigned to you.

Assigned to my roles Displays the requests assigned to the role you select.

Assigned to my subordinates Displays the requests assigned to the 
subordinate you select. Subordinates are users who are lower than you in the 
approval hierarchy. This option is available if the Requisition Administrator set 
you up as an extended approver, allowing you to approve purchase requests 
assigned to your subordinates.

3. Select the request to modify and click Edit Request. The Purchase Request 
Details page appears.

Option Description

Save for later Saves the request without approving it.

Approve and send the 
purchase request to

Approves the request and routes it to someone other than your default 
approver. Depending on your permissions, you might be able to select 
your approver, or the Requisition Administrator might assign a default 
approver to you.

Submit to final approver Routes the request to the next person in the approval hierarchy who 
has final approver status. This option is available if the purchase 
request amount is within your approval limit, but you don’t have final 
approval permission.

Final Approve Gives the request final approval and sends it to the Requisition 
Purchaser. This option is available if the purchase request amount is 
within your approval limit and you have final approval permission.

Return purchase 
request to

Returns the request to the user you select. See Returning a purchase 
request to another user on page 21 for more information.

Reject Returns the request to its creator. See Rejecting a purchase request on 
page 22 for more information.

Void Voids the request and sends it to history. See Voiding a purchase 
request or line item on page 22 for more information.
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4. To modify the item information, select one of the following actions:

• To modify an item, select the item and click Edit Item. The Edit Item dialog 
box appears, where you can modify the item. Click Save and Close when 
you’ve finished.

• To add a new item to the request, click New Item. The Add Item dialog box 
appears, where you can add an item. Click Save and Close when you’ve 
finished.

• To void an item on the request, select the item, click Void Item, and click 
Save. The voided item is moved to history.

5. If you have any comments about the request, enter them in the Comments field.

6. Click Approve to approve the request. 

You also can click Show More Tasks to view additional tasks and more flexible 
routing options. See Additional approval tasks on page 20 for more information.

Returning a purchase request to another user

You can use the Purchase Request Details page to return a purchase request to 
another user for changes or additional information. For example, you might return 
a request to another user for changes if you need clarification, if you think an item 
should be removed, or if you think a different vendor should be used. 

You can return a purchase request to a user only if the request has already been approved at 
least once.

The user you’re returning the purchase request to will receive a notification that the 
request has been returned. When any necessary changes are made, that user can 
again submit the request.

To return a purchase request to another user:
1. Open the Purchase Requests page.

Manager > Purchase Requests

2. In the Filter by list, select one of the following options:

Assigned to me Displays the requests assigned to you.

Assigned to my roles Displays the requests assigned to the role you select.

Assigned to my subordinates Displays the requests assigned to the 
subordinate you select. Subordinates are users who are lower than you in the 
approval hierarchy. This option is available if the Requisition Administrator set 
you up as an extended approver, allowing you to approve purchase requests 
assigned to your subordinates.

3. Select the request to return and click Edit Request. The Purchase Request 
Details page appears.

4. Enter your comments about the request in the Comments field.
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5. Click Show More Tasks. 

6. Select Return purchase request to and select a user or role. 

Only the users or roles who previously approved the request are included in the 
list. If the purchase request was previously rejected, only the users who 
approved the request since it was resubmitted will be listed.

7. Click OK. The user you’re returning the purchase request to will receive a 
notification and can resubmit the request for approval.

Rejecting a purchase request

You can use the Purchase Request Details page to reject a purchase request. For 
example, you might want to reject a request if you don’t think the purchase is 
necessary.

When you reject a request, it will be routed back to its creator. That user then can 
void the request or resubmit it for approval.

To reject a purchase request:
1. Open the Purchase Requests page.

Manager > Purchase Requests

2. In the Filter by list, select one of the following options:

Assigned to me Displays the requests assigned to you.

Assigned to my roles Displays the requests assigned to the role you select.

Assigned to my subordinates Displays the requests assigned to the 
subordinate you select. Subordinates are users who are lower than you in the 
approval hierarchy. This option is available if the Requisition Administrator set 
you up as an extended approver, allowing you to approve purchase requests 
assigned to your subordinates.

3. Select the request to reject and click Edit Request. The Purchase Request 
Details page appears.

4. Enter any comments about the request in the Comments field.

5. Click Show More Tasks. 

6. Select Reject.

7. Click OK. The request will be routed to its creator.

Voiding a purchase request or line item

You can use the Purchase Request Details page to void a purchase request or line 
item if the request or line item is no longer valid. You can void a request or line item 
only if the request has been submitted and none of the line items have been 
transferred to a purchase order. 
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When you void a purchase request, both the request and all of its line items are 
voided and moved to history. If you void a line item, the line item will remain on 
the purchase request, but the line item will be designated as having been voided.

The purchase request must include at least one non-voided line item before it can be 
approved.

To void a purchase request or line item:
1. Open the Purchase Requests page.

Manager > Purchase Requests

2. In the Filter by list, select one of the following options:

Assigned to me Displays the requests assigned to you.

Assigned to my roles Displays the requests assigned to the role you select.

Assigned to my subordinates Displays the requests assigned to the 
subordinate you select. Subordinates are users who are lower than you in the 
approval hierarchy. This option is available if the Requisition Administrator set 
you up as an extended approver, allowing you to approve purchase requests 
assigned to your subordinates.

3. Select the request you’re voiding or the request that contains the line item 
you’re voiding and click Edit Request. The Purchase Request Details page 
appears.

4. Complete one of the following tasks:

• To void an item, select the item and click Void Item. A message appears 
asking if you want to void the line. Click Yes. The line item will remain on 
the request, but the line item will be designated as having been voided. 
Click Save to save the request or Approve to approve it. 

• To void the request, click Show More Tasks. Select Void and click OK. A 
message appears asking if you want to void the purchase request. Click 
Yes. The request and all of its line items are voided and moved to history.
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Chapter 4: Purchaser Tasks
Use the following information to convert purchase requests from Business Portal 
into purchase orders in the Great Plains back office system. Purchaser task 
information is explained in the following sections:

• How purchase requests are converted to purchase orders
• Converting purchase request items to a purchase order
• Modifying a purchase request line item
• Voiding a purchase request line item

How purchase requests are converted to purchase 
orders

When an approver gives a purchase request final approval, the request is routed to 
the purchaser, who can convert the request line items into new or existing purchase 
orders in Great Plains. 

During the transfer process, you can consolidate identical line items from different 
purchase requests into one line item for one vendor. For example, if three users 
request the same filing cabinet from the same vendor, those line items can be 
consolidated into one line item with a quantity of 3. 

To be consolidated, the following attributes of the line items must be the same:

• Item number
• Description
• Unit of measure
• Site ID
• Vendor
• Account
• Unit price
• Required-by date

If the line items aren’t identical, you might be able to modify the line items so they 
can be consolidated into one line item, depending on how the Requisition 
Administrator set up the system. See Modifying a purchase request line item on page 26 
for more information.

Converting purchase request items to a purchase 
order

Use the Create Purchase Orders page to select the line items to transfer to new or 
existing Great Plains purchase orders for a vendor. All purchase request line items 
that have been given final approval can be transferred to Great Plains. Depending 
on how the Requisition Administrator set up the system, you might be able to 
modify the line items before you convert them to purchase orders in Great Plains. 
See Modifying a purchase request line item on page 26 for more information.
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To convert purchase request items to a purchase order:
1. Open the Create Purchase Orders page.

Purchasing > Requisitions

2. In the Filter by list, select a vendor and click the arrow button to display the 
purchase requests that have been given final approval for that vendor.

3. Select each item to transfer to a purchase order. You can select up to 300 items at 
one time. 

4. Verify that the information on each request is correct. To modify or void any 
line items, see Modifying a purchase request line item on page 26 and Voiding a 
purchase request line item on page 27.

5. You can select Consolidate identical items on purchase order to consolidate 
identical items. All items with the same item number, item description, unit of 
measure, site, vendor, account, price, and required-by date will be consolidated 
onto one line. See How purchase requests are converted to purchase orders on 
page 25 for more information.

If you consolidate identical items, line item comments aren’t included on the purchase 
order. 

6. You can select Add to existing purchase order and select a purchase order from 
the list to add line items to an existing purchase order. The line items on the 
existing purchase order must have the same vendor and currency as the line 
items you’re adding.

7. Click Create, and then remain on the page until the processing has been 
completed:

• If the process is successful, the Purchase Order Confirmation dialog box 
appears, displaying the purchase order number and the vendor 
information. 

• If the process is not successful, the Purchase Order Failure dialog box 
appears, displaying the reason why an item was not added to the purchase 
order.

Modifying a purchase request line item

Use the Create Purchase Orders page to modify purchase request line items before 
transferring them to a purchase order. For example, you might modify line items if 
they aren’t identical and you want to consolidate them into a single line item. 

You can modify purchase request line items only if the Requisition Administrator 
set up the system to allow modifying purchase requests after they’ve received final 
approval.

To modify a purchase request line item:
1. Open the Create Purchase Orders page.

Purchasing > Requisitions

2. In the Filter by list, select a vendor and click the arrow button to display the 
purchase requests that have been given final approval for that vendor.
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3. Select the item to modify.

4. Click Edit Item. The Edit Item dialog box appears, where you can modify the 
item. 

5. After you’ve finished modifying the item, click Save and Close.

You then can convert the line item to a purchase order. See Converting purchase 
request items to a purchase order on page 25 for more information.

Voiding a purchase request line item

Use the Create Purchase Orders page to void a purchase request line item if it’s no 
longer valid. You can void a line item only if it hasn’t been transferred to a purchase 
order. When you void a purchase request line item, it will be moved to history. 

You can void purchase request line items only if the Requisition Administrator set 
up the system to allow modifying purchase requests after they’ve received final 
approval.

When you void line items on a purchase request that has received final approval, 
the status of the request will depend on whether any of the line items have already 
been transferred to a purchase order:

• If any line items have been transferred to a purchase order, and you void the 
remaining line items that can be voided, the purchase request is moved to 
history and the status of the request is Transferred To Purchase Order.

• If no line items have been transferred to a purchase order, and you void the line 
items that can be voided, the purchase request is moved to history and the 
status of the request is Voided.

To void a purchase request line item:
1. Open the Create Purchase Orders page.

Purchasing > Requisitions

2. In the Filter by list, select a vendor and click the arrow button to display the 
purchase requests that have been given final approval for that vendor.

3. Select the item to void.

4. Click Void Item. A message appears asking if you want to void the item. Click 
Yes. The voided item is moved to history.
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Documentation Comment Form
Business Portal Requisition Management User’s Guide 
January 2005

We welcome your comments and suggestions regarding the quality and usefulness 
of this manual. Your comments help us improve the documentation to better meet 
your needs.

• Did you find any errors?

• Is the information clearly presented?

• Are the examples correct? Do you need more examples?

• What features do you like most (and least) about the documentation?

If you find errors or have specific suggestions, please note the topic, chapter, and 
page number.

Send your comments using any of the following methods:

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

E-mail bizdoc@microsoft.com

Fax 425-936-7329.
(On the cover sheet, specify that the fax should be routed 
to the bizdoc@microsoft.com e-mail address.)

Conventional mail Documentation Manager
Microsoft Business Solutions
One Lone Tree Road
Fargo, ND 58104-3911

mailto:bizdoc@microsoft.com
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